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Software Kit Contents  

The software kit includes five CD-ROMs (CD-ROM #1, CD-ROM #2A, CD-ROM #2B, CD-
ROM #2C, and CD-ROM #3). Each CD-ROM is described below.  

CD-ROM #1 for the DocuColor 5252, and DocuColor 2000 Series 
This CD-ROM includes the Microsoft® Windows® 2000 Professional operating system with a 
customized menu for reinstalling the CXP5000 Color Server.  

Note:  This version includes Internet Explorer 6.0 and Service Pack 3.0. 

CD-ROM #2B for the DocuColor 2000 Series 
This CD-ROM contains the CXP5000 multilingual application software (setup files, PPD files, 
printer drivers, and utilities). 

CD-ROM #2C for the DocuColor 5252  
This CD-ROM contains the CXP5000 multilingual application software (setup files, PPD files, 
printer drivers, and utilities). 

CD-ROM #3 for the DocuColor 5252, and DocuColor 2000 Series 
This CD-ROM contains the utilities, and the CXP5000 User Guide. It also contains the customer 
release notes in PDF files in the following languages, English, French, German, Spanish, Italian, 
Portuguese, and Dutch. 

The CD-ROM has both Macintosh® and Windows partitions and can be mounted on both 
platforms. You can add the Installation Guide and Printing Guide to any client workstation that 
has a CD-ROM drive and send the guides to any printer. You can submit the guides via the 
CXP5000 Color Server, and print them on the DocuColor 2045 and 5252 printers. 
To print the CXP5000 User Guide on the DocuColor 2045 and 5252 printers using the 
CXP5000 application: 

1. Make sure that the Spire CXP5000 workspace is open, and then insert CD-ROM #3 (Spire 
CXP5000 Color Server Documentation and Utilities) into the Spire CXP5000 CD-ROM 
drive. 

2. From the File menu, select Import Job. 

3. Browse to the CD-ROM, and select a file. 

4. Click Add to List. 
The file appears on the right side of the Import Job dialog box. 
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5. Click Submit.  
The selected file is submitted to the Spire CXP5000 color server to print. 

New Features  

New Graphic User Interface 

Spire CXP5000 color server 4.0 software has a new design for the user interface. The user 
interface has been improved and updated.  

Workspace- New Interface 

The Spire CXP5000 color server workspace includes the following changes: 

• The Pathways panel was removed.  

• A toolbar was added, and includes the following buttons: 

Icon Name Description 

 Import button Shortcut to Import window. 

 Resource Center button Shortcut to Resource Center 

 Message Viewer button Shortcut to Message Viewer  

 Calibration button Shortcut to Calibration process 

• The suspend/resume buttons for the Print Queue and Process Queue are in the Queues 
title area. 

• Except for the workspace, all windows within the workspace are resizable.  

• You can dock and undock all windows in the workspace. This option is available when you 
right-click the title bar in a window. 
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• You can drag and reorder columns, remove columns, and change a column’s view. This 
option is available when you right-click the title bar in a column. 

• The Alerts window has been improved, and now includes a separate area for alert 
descriptions. 

• The Job status icons have been updated. 

Queue Icon Job Status 

 Completed jobs 

 
Failed jobs 

 Held jobs 

Storage window  

 Aborted jobs 

 Job is running 

 Job is in freeze mode (held 
in Print Queue) 

 Job is waiting 

 Rush job 

 Rush job in freeze mode 

Print Queue and 
Process Queue 

 Rush job is waiting 
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View Menu 

A View menu was added to the CXP5000 menu bar.  

 

The View menu contains the following options: 

• Open or close the Process Queue, Print Queue, Storage window, Alerts window, 
Thumbnail window and Paper Stock window 

• Spire classic view: Displays the Status panel, CXP5000 toolbar, Storage window, Print 
Queue and Process Queue, Thumbnail window and Alerts window 

• Spire classic plus view: Displays the Status panel, CXP5000 toolbar, Paper Stock window, 
Storage window, Print Queue, Process Queue, Thumbnail window and Alerts window 

• Queues window: Displays the Print Queue and Process Queue 

• Refresh view: Enables you to go back to the factory default view for the view that is 
currently displayed  

All views are customized; the CXP5000 workspace will always display the last view. 

New Options in the Tools Menu 

The Tools menu includes the following new options:  

• Settings: Contains all system preferences, the window is divided into two lists, 
Administration and Preferences 
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• Administration: This list contains the following items, Server Setup, Network Setup, 
Remote Tools Setup, Security, System Disks, Configuration Backup 

• Preferences: This list contains the following items, Localization (units and languages), 
Pre-Rip Preview, General Defaults (default image size, OPI, Default archive path), 
Print Queue Manager, Color, Messages, View Configuration 
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• Resource Center: Enables you to add, remove, and manage CXP5000 external resources. 
The Resource Center provides the following features, Virtual Printers, Cached VI 
Elements, Fonts, Profile Manager, User defined Imposition templates, Paper sets. 

 

Job Parameters Window - New Interface 

The basic structure of the Job Parameters window remains the same. The Status bar now 
includes the name of the virtual printer that is used when you import a job. 

  

 

Selected Tab 

Feature Options Area 

Selected 
Values

Selected Parameter 
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Handling Conflicts 

If there are conflicts in the Job Parameters window, the Conflict window displays the two 
parameters that conflict—for example, Transparency conflicts with duplex printing. You can’t 
print your job until the conflict is resolved. 

 

To resolve the conflict, select one of the following options: 

• In the Resolve Options area, select a resolve option, and then click Resolve. 

• Click Cancel to remove the value you selected for the last parameter. 

Changes to the Print Settings Tab 

The Print order parameter is new, and contains the following options, 1 to N, N to 1. 

The Delivery parameter is new, and contains the following options, Face up, Face down. 

Changes to the Color Tab 

• The Spot color workflow parameter was added to the Color tab. This parameter enables you 
to decide whether or not to use the Spire Spot color dictionary.  

Note:   This option was removed from the Administration window. 
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• The Emulate RGB Element and Preserve pure colors options were added to the Job 
Parameters window, and can be found on the Color tab>CMYK workflow>Emulation.  

Note:   This option was removed from the Administration window. 

• The Print grays using K toner option is now in the RGB workflow.  

• The Destination parameter was added to the Job Parameters window. This parameter enables 
you to assign a destination profile to a job.  

• The Color Adjustments parameter contains Brightness, Contrast, and Gradation options.  

Changes to the Services Tab 

The APR window has been enhanced, and includes the Search in the input folder check box. 
This check box is available each time you add an APR path. 

 

Changes to the Exceptions Tab 

The Exceptions tab can be displayed in two different views. 

The following screen capture shows the Exceptions tab for regular page exceptions. 
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The following screen capture shows the Exceptions tab for jobs that were imported via a 
dynamic page exceptions virtual printer.  
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Backing Up and Restoring the System 

The Spire CXP5000 color server has a system backup and restore procedure that shortens the 
reinstallation and configuration process of the Windows operating system.  

The System Backup and Restore procedure is available on CD-ROM #1.  
To backup the system: 
1. Insert CD-ROM #1, which includes the backup and restore procedure, into the CD/DVD-

ROM drive, and then restart your workstation. 

2. When the menu appears, select Backup. 

3. The backup procedure begins. 
When the procedure is finished, remove the disk. 

To restore the system: 
1. Check if the following directory exists, D:\Backup. 

2. Insert CD-ROM #1,which includes the backup and restore procedure, into the CD/DVD-
ROM drive, and then restart your workstation. 

3. When the menu appears, select Restore.  
This will restore the last backup of the system C:\drive 

XPIF Support 

The Spire CXP5000 color server can receive Xerox Programming Information Format (XPIF) 
and automatically convert this format to Spire CXP5000 color server job parameters. 

Note:  The Spire CXP5000 color server does not fully support staple options from a client 
workstation. Some options may cause a file to fail in print, and some options will cause a file to 
print with the wrong orientation. 

Security Features 

The Spire CXP5000 color server has new and improved security features. 

Feature Access Control  
This feature enables you to distinguish between three possible access levels on the Spire 
CXP5000 color server:  

• Administrator – User has the highest access level and privileges to all Spire color server 
options 

• Operator – User can fully operate the Spire application, but can’t edit any of the 
Administration items in the Settings window 
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• Guest – Temporary user that can only submit a job using an existing virtual printer.   

By default, the Spire CXP5000 color server is set to Auto Log On. This option enables you to 
operate the Spire CXP5000 color server as an administrator. If you want to designate different 
access levels for each user, you need to set Security settings in the Settings window.  

 

The following options are available in the Security window: 

• Auto Log On: Enable users to log on automatically without going through the Logon dialog 
box 

• Change Administrator and Operator passwords (Guest does not require a password)  

• Disable Guest Connection: Prevents guest users from accessing the Spire CXP5000 color 
server 

If you clear the Auto Log On check box, you will have to log on to the Spire CXP5000 color 
server via a Logon dialog box. This dialog box appears when you attempt to load the Spire 
CXP5000 color server application. 
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The Logon dialog box enables you to log on to the Spire CXP5000 color server with a 
designated access level and password. 

Note:  If you are already logged on to the Spire CXP5000 color server workspace you can 
change your access level—for example, if you are logged on as an operator and you need 
administrator privileges. To change your access level, from the Job menu, select Logon as a 
different user. 

Note:  If you forget your password, use one of the following recovery options: 

• Auto log on option 

• Reinstall the Spire CXP5000 color server application 

Disk Wipe 
Normally, when you delete a file, the file’s dictionary entry is removed but data still 
remains on the disk. The Disk Wipe utility enables you to clear previously deleted 
files. Disk Wipe eliminates the contents of your deleted files by scanning all of the 
empty sectors on the disk and replacing them with zeros. Nonempty sectors are left 
untouched. This feature enables you to work in a more secure environment. 
If there is a system shutdown, the disk wipe operation can begin immediately.  
To select the disk wipe operation: 
1. Go to Administration>Security. 

2. In the Disk Wipe area, select the Wipe disk on system shutdown check box. 

Dynamic Page Exception Enhancements 

• The Preflight parameter enables you to check if your file includes dynamic page exception 
commands. The new Dynamic Exceptions check box can be found under the Preflight 
options area.  
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• More dynamic page exception commands within a job are supported: 

o True Inserts within a job 

o Plex SPD commands 

o XRX commands in PDF 

Enhanced Brisque Connectivity 

The Spire CXP5000 color server enables enhanced Brisque connectivity. You can install 
Microsoft Windows Services for UNIX (SFU) version 3.0 on the Spire CXP5000 color server. 
Windows SFU version 3.0 adds UNIX NFS (Network File System) protocol compatibility to a 
Windows workstation. This compatibility enables UNIX platforms to mount the workstation’s 
volume. 

After you complete the SFU installation, the Send option from the Brisque File Manager is 
available to the Spire CXP5000 color server hot folders or shared volumes. 

Note:  The Spire CXP5000 color server does not support PSM (Brisque station on Mac 
platforms). 

Pre-Separated Files Support 

The Spire CXP5000 color server now supports Pre-Separated PostScript files and DCS Files. 
These files will be printed as composite files. 
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Limitations: Pre-Separated files conflict with the following parameters, Color 
mode=Grayscale, Exceptions and Admin page. 

Custom RGB Profiles Support 

You can import RGB source profiles via the Profile Manager. After you import an RGB source 
profile, it appears in the Color tab>RGB Workflow parameter. 

Font Downloader for Windows Fonts 

The Spire CXP5000 color provides a special hot-folder for downloading fonts from a Windows 
client workstation. The hot folder is published in the Spire CXP5000 color server D:\Hot 
Folders \ HF_Fontdownloader. 

You can use the HF_Fontdownloader hot folder to install new or missing fonts to the Spire 
CXP5000 color server fonts dictionary. You can drag the hot folder to your desktop to create a 
short cut. The fonts are installed when you drag the fonts to the HF_Fontdownloader hot folder.  

The following client operating systems are supported: 

• Windows 2000 

• Windows NT 

• Windows XP 

• Windows 98 

• Windows ME 

The Spire CXP5000 color server supports the following font types, True type and Type 1 (PFA 
& PFB).  

Note:  After you restart the Spire application, installed fonts are displayed in the Resource 
Center>Fonts. 
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Calibration Enhancements 

Calibration Reminder 

 

You can set the Calibration Reminder to remind you when to perform calibration. Select the 
check box under Preferences>Color. The calibration reminder indicator will appear on the 
printer icon when you need to calibrate.  

 

Coated and Uncoated Calibration 
The Spire CXP5000 color server is provided with different targets for coated and uncoated 
paper. As a result, two different look up tables are produced for coated and uncoated paper. This 
enables you to take advantage of the large gamut provided for coated paper. 

Coated and Uncoated Destination Profile 
The Spire CXP5000 color server is provided with different destination profiles for coated and 
uncoated paper. For each predefined destination profile (GA or COM), the Spire CXP5000 color 
server has two destination profiles, coated and uncoated. 

The correct destination profile is used according to the paper stock you select: 
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• If the coating that is selected is coated, a coated destination profile is used for the color 
transformation. 

• If the coating that is selected is uncoated, an uncoated destination profile is used for the color 
transformation. 

Note:  A change in coating may cause re-RIP. 

Image Position on a Page Level 

The Exceptions tab was enhanced and enables you to use the image position tool to shift an 
image on a specific page or range of pages. To define an image position on a specific page or 
range of pages, select the Exceptions tab, define the page range, and then click Advanced to 
define the shift. 

Perform the following steps to define the image position: 

1. Click Advanced. 

 

2. Clear the same as job check box.  

3. To shift an image, follow one of these steps: 

a. Click the arrows to shift the image on both sides. 

b. Type a value in the Rear and Lead boxes  

c. To set the values back to 0.0, click Center Image 

4. Click Save. 

5. Click Apply to add changes to the selected range. 
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PDF2Go Enhancement 

You can now export RTP files as PDF2Go files. There are two output resolutions available: 

 

• Print Optimized - Generates a high-resolution PDF file in 300dpi. 

• Screen Optimized - Generates a low-resolution PDF file in 72 dpi, use this option when you 
want to generate a light PDF file—for example, a file that you can send as a proof by e-mail. 

Revert to source 

You can now remove the raster data of an RTP job. This option is available for jobs in the 
Storage window. Right-click a job and select Revert to Source. 

Split to Booklets Enhancements 

You can now use the Split to booklets parameter for a VI job. A VI job that has one booklet 
structure can be split.   

Note:  Unexpected results might occur when you use this option for VI jobs that already have a 
booklet structure. 

New Imposition Templates 

The following step & repeat templates were added to the Spire CXP5000 color server predefined 
list, 9 x 3, 3 x 9, 5 x 4, 4 x 5, 2 x 4, 3 x 3, 5 x 6, and 6 x 5. 

Support for New Languages  

The Spire CXP5000 color server workspace and PPD file supports two additional languages, 
Turkish and European Portuguese. 
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Web Viewer API 

The Web Viewer API enables you to retrieve information about the job list and printer status via 
XML files. 

The JobList.xml file contains details about the job status for the In Print queue, In Process 
queue, and the Storage Folder.  

To retrieve the JobList.xml file, type the following URL: 
http://<ComputerName>/WebViewer/GetView.asp?View=JobList_xml. 

The PrinterStatus.xml file contains data about the printer status.  

To retrieve the Printerstatus.xml file, type the following URL: 
http://<ComputerName>/WebViewer/GetView.asp?View=PrinterStatus_xml. 

Printing Grays with K Toner 

In Device Link Mode, the ‘Print grays using black toner’ option affects only RGB elements 
that are text or graphics elements. Images will not be affected by this option. 

  
The Print Grays using black toner option not only affects R=G=B values, but may also cause 
slightly different values (R+/-4=B+/-4=G+/-4) to produce gray. 

Note: In CSA mode, this option will affect also RGB Image data. 
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Incorrect Number of Pages Used in the Staple Option 

• If a staple option is applied to a single page job, the page will be printed to the HCSS Stack 
Tray without being stapled. 

• If a staple option is applied to a job that contains too many pages, the job will fail in the 
Print Queue, and the following message will appear in the Alerts window, “Job can’t be 
printed and stapled due to page quantity, cancel the staples option.” 

Heavy Inserts Enhancements 

Heavy weight inserts to a duplex job, such as transparencies or 220gsm, are now supported. 

VIPP 5.1 

The Spire CXP5000 color server now supports VIPP 5.1.  
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Tips for Using the Spire CXP5000 Color Server  

Running Antivirus Software 

The Spire CXP5000 color server was successfully tested with McAfee® VirusScan® 7.0 for 
Windows 2000 Professional server antivirus software. Avoid using the automatic scanning mode 
and activate the antivirus software only when the Spire CXP5000 color server application is 
closed.  

Before you install the Spire CXP5000 color server, make sure that you close all other 
applications, including antivirus applications.  

Note:  McAfee VirusScan is not included in the software kit.  

Loading Third-Party Software 

Except for the antivirus software, do not load unauthorized software onto the Spire CXP5000 
color server. 

Adding Printers on Client Workstations 

To install printers on client workstations, it is recommended that you use the Adobe PostScript™ 
driver utility from CD-ROM #3.  

Note:  When you update or install a new version, you must remove the old printers from the 
client workstation and install the new ones.  

Printing a DCS File 

The CXP5000 can process input files with embedded DCS1 or DCS2 (Adobe® Photoshop®) 
format files. 
To print a DCS file: 

1. Place the DCS file in a desktop publishing application such as QuarkXPress® or FreeHand®. 

2. Copy the DCS file to the Spire CXP5000 color server High Res folder (D\Shared\High 
Res). 

3. In the Job Parameters window or in the PPD, select the Print Quality tab.  

4. In the PS Overprint options, select Yes. 
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5. Print the file in composite mode. 

Note:  You can use a different path for the high-resolution DCS files. Make sure you add the 
path to the Creo APR search paths on the Services tab in the Job Parameters window. 

Setting Collation Options 

Most printer drivers and Microsoft Office applications support a collation option. To receive 
properly collated or stapled output, clear the Collate option in the print driver and in the 
application, and then select the Collate option in the PPD file. 

Reverting to the Default Normal or Saturated Calibration Table 

If the Normal or Saturated calibration table has been edited, and you wish to revert to the Spire 
CXP5000 color server default calibration table, perform the following steps: 

1. From the Tools menu, select Calibration. 
The Calibration window appears.  

2. From the Calibration Name list, select SpireNormal or SpireSaturated. 

3. Click Edit. 
The Edit Calibration window appears. 

4. Click Save As.  
The Save As dialog box appears. 

5. In the File Name box type Normal or Saturated. 

6. Click OK. 
A message appears. 

7. Click Yes.  

Embedded ICC Profiles  

Adobe and the Spire CXP5000 color server support PostScript color management, CSA and 
CRD workflows. The CSA is extracted from the ICC profile only when you select PostScript 
color management in your DTP application. The Spire CXP5000 color server uses the embedded 
CSA when you set the RGB Workflow or CMYK Workflow parameters to Use Source CSA 
(Job Parameters window>Color tab). 
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CMYK Emulation 

Avoid ICC profile names that contain spaces or the improper characters. Examples of invalid 
characters are as follows:! @ # $ % ^ & * ( ) - / ? > < ' " ; : ] [ { } \ 

Printing a Range of Pages (HCSS) 

For duplex printing, enter page numbers that have a continuous page range. For example, type 
1-10. Don’t enter page numbers that are separated by a comma. For example, do not type 
5,10,12. 

Ensuring Font Substitution 

If the Spire CXP5000 color server fails to substitute fonts and no fonts are printed in the output, 
clear the Font Substitution Off check box in the virtual printer. 

Selecting Staple Options 

Regardless of whether the image orientation is set to Portrait or Landscape, the available staple 
options include both Portrait and Landscape. Be sure to select the staple orientation option that 
matches your image orientation. If you do not, the image might be cropped. 

Setting the Image Size to Trim Size Ratio in Imposition 

Be sure to set the ratio of image size to trim size in to less than 3.0. If the value is greater, the job 
might fail to print. For example, do not place two tabloid size images that are trimmed to letter 
size on a tabloid size sheet. 

Printing from a Macintosh: Driver Requirements  

The supported Mac OS® is 9.x. and later. The recommended printer driver depends on the 
version of the operating system that you use. Unknown problems can occur if other drivers are 
used. 

Mac Recommended Printer Driver 

9.x. and higher LaserWriter 8.7 

The Spire CXP5000 color server does not require any driver installation for Mac OS X. To print 
to the Spire CXP5000 color server from Macintosh OS X, use the Print Center application, and 
then select Add to add the virtual printer. 
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Printing from Windows: Driver Requirements 

Windows Recommended Printer 
Driver 

Windows NT®, 2000, XP  Adobe PostScript® Driver 5.2.1 

Windows 98®, ME  Adobe PostScript Driver 4.5.2 

Note:  Windows NT and 2000 clients may be required to log on to the Spire CXP5000 color 
server printer after rebooting or when logging on as a different user. The default log on name is 
“operator” and the password is “spire.” 

Adjusting the Text Line Quality Parameter 

When a job contains complicated graphic work (line work) and the Text Line Quality parameter 
in the Job Parameters window is set to High, the following message may appear:  

Job <Job Name>cannot be processed with Text/Line Quality High. 
Change the Text/Line Quality parameter to Normal and resubmit the 
job. 

Follow the instructions in the message. 

Choosing a System Disk for Operations 

Do not perform any operations, such as archiving, on disk C. Perform these operations on disk 
D. 

Creo Spot Colors XT Version 2.3.1 

It is recommended not to work with Creo Spot Colors XT version 2.3.1XTension when you use 
QuarkXPress. 

Deactivating OPI 

When you use Creo APR in the Spire CXP5000 color server make sure that the OPI XTension in 
QuarkXPress is not active. Alternatively, in the Settings window>Preferences>General 
Defaults, clear the Enable OPI Spire Support check box. 

Printing an Area of 12 × 18 inches 

Use paper that is 12.6 × 19.2 inch paper to print a full print area of 12 × 18 inches. 
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Web Viewer 

To connect to the Spire CXP5000 color server from a Macintosh client workstation, use the 
Spire CXP5000 color server IP address. You can obtain the IP address from the Spire CXP5000 
color server>Network tab. 

The Web Viewer runs only on Explorer 5.0 browsers and higher and is suitable for both 
Macintosh and Windows platforms. 

Spire DC2060_DC6060_COM Destination Profile 

If a job that contains shades of blue does not print to your satisfaction—for example, the blue 
shades appear too purple—use the predefined SpireDC2060_6060COM destination profile, and 
then use the required emulation. 

Spire Printing Over TCP/IP From Macintosh 

The Spire over TCP/IP connection enables Macintosh clients to print jobs to the Spire CXP6000 
color server over a TCP/IP protocol. This connection allows a significantly higher spooling 
speed. 

To set up TCP/IP printing from the Macintosh, download the Choose Spire Over IP installer 
from the Spire CXP5000 color server D:\Utilities folder. For more information see the Spire 
CXP5000 Color Server User Guide.  

Note:  To enable the Spire Over TCP/IP connection, a Macintosh OS version 9.x or higher, with 
an installed LaserWriter application version 8.6 or higher, or AdobePS 8.8 or higher is required. 
If you do not have a compatible LaserWriter application installed, you can download this 
application from the Spire CXP5000 color server, under D:\Utilities\Mac utilities folder. 

Coated paper   

Be sure the coated paper media weight programmed in the Job Ticket or ppd matches the actual 
weight set in the DocuColor Digital Color Press. 
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Spire CXP5000 Color Server Limitations 

Admin Page 

• When you print the Admin Page, the Color Server Name box displays the name of the 
color server as it appears on a Macintosh client workstation and displays the client 
workstation name as it appears on a Windows client workstation. 

• When you print the Admin Page, the Sender Name box displays the owner name as it 
appears on the Macintosh OS 9.x client workstation and displays the user name as it appears 
on Macintosh OS X.  

• In imposition, when you select the Fit to Page option for the Admin Page, the image scale 
changes. 

• The Admin Page is printed only in English.  

• Updates to the Admin page will require the job to be re-processed  after making changes in 
the Jot ticket parameters.  

Merged RTP Jobs 

After you merge jobs in the Job Preview & Editor tool, do not change any job parameters that 
require re-RIPing, such as Color Emulation, and Image Quality. 

Progressive JPEG Images 

Progressive JPEG images are not supported. 

Hot Folders  

• You cannot import TIFF files to the Spire Color Server via a hot folder. 

• Submit Brisque jobs under foldername.job and not just the .assign file. 

• Submit single pages of a Brisque job under foldername.p. 

• In Windows 98, if the printer name is more than eight characters; the hot folder name and 
icon do not appear.  

• In Windows ME, if the printer name is more than 11 characters; the hot folder name and icon 
do not appear.  
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Note:   You may save these virtual printers under a shorter name and use their corresponding 
hot folders instead. 

Exceptions for Imposed Jobs 

• When you use the Step & Repeat template with the Cut & Stack option, the Exceptions tab 
is unavailable. 

• In imposition, you cannot set paper size as an exception.  

• In impostition, do not use the Front cover or Back cover parameters to print front or back 
covers. Instead, use the Exceptions tab in the Job Parameters window, and specify sheet 
number one as an exception in the job. 

Mapping Option in Profile Manager 

The Mapping feature doesn’t always function as expected in this version; destination profiles 
that are assigned to specific paper colors do not take effect on the print results. 

Dynamic Page Exceptions Support 

If you print a job using a dynamic page exceptions virtual printer, Imposition tab in the Job 
Parameters window is unavailable. 

Imposed Sheet Range 

This feature is available only for imposed RTP jobs. 

For imposed, non-VI RTP files, the Page Range is automatically changed to Imposed Sheet 
Range. An exception is that for such step-and-repeat files, the print range is Page Range and not 
Imposed Sheet Range. 

For imposed VI RTP files, the print range is Booklet Range. For cut-and-stack files, however, 
the print range parameter is unavailable. 

A sheet refers to one side of the physical piece of paper. In duplex printing, each sheet is counted 
twice, for example—sheet 1, would have, side A and side B. 

Image Noise 

Image noise affects only continuous tone (CT) elements. 
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Imposed Sheet View 

The Imposed Sheet tab is available only for imposed RTP jobs. 

If you merge an imposed RTP job, you need to save the newly merged job. Then you can 
preview the new imposed sheet with the Job Preview & Editor tool. 

Export as Insite 

Export as InSite is available only for non-VI RTP files.  

Note: Synapse InSite is an Internet portal that provides customer interaction via Web UI, 
uploads/downloads, and track Job activities, and add Job notes and approval cycle. 

Novell Banner Page 

A banner page in a Novell network is not supported. 

Image Scale  

You cannot use the Image Scale parameter with the PDF Optimization utility. 

If you select the Image Scale parameter, it automatically clears the Enable PDF Optimization 
checkbox. 

The Image Scale parameter does not support VI jobs. 

Fit to Sheet Size in Imposition 

The Fit to Sheet Size check box on the Imposition tab (Template parameter) does not support 
VI jobs. 

The Fit to Sheet Size check box on the Imposition tab (Template parameter) cannot be used 
with the PDF Optimization utility. 

LPR Printing 

All LPR commands that are related to job programming such as Print Method or Number of 
Copies are not supported.  
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Mixed Paper Size in a Job 

To print a job that uses mixed paper sizes, make sure that you place all of the paper in the same 
feed direction—for example, SEF or LEF.  

Importing Files from the Network 

Before you import a file from the network, establish a connection with the relevant host. 

Drive A:\  

Drive A:\ is not available in the Spire CXP5000 color server Import window, Open dialog box, 
or any such file management dialog boxes. 

Front and Back Cover for Saddle Stitch 

If a cover is added to a file that has the saddle stitch option selected, the middle page of the 
booklet will be printed on the paper stock used for the cover. 

Backup & Restore configuration 

When restoring configuration from backup, note that not all user define resources (e.g. Virtual 
printer, custom profiles) are restored back properly, also Paper set list can’t be restored. 

External CD 

Importing files directly from CD or defining high-res path to a CD is not recommended.  Please 
copy related files to a shared folder. 

Variable Information (VI) 

Variable Print Specification Process 
It is recommended that you use the Creo Darwin application version 4.5 or later. 

In general, the DocuColor models 2045 and 5252 handle variable information jobs efficiently in 
segmented run lengths. You should always break down large complex jobs into smaller run 
lengths to achieve maximum throughput. The exact size of the run length depends on the amount 
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of variable coverage and the element’s demographics (the size and percentage of variable text as 
compared to images and graphics). 

You should perform regular disk maintenance to ensure trouble-free operation. 

Printing Retrieved VIPP jobs  

If you want to print a retrieved VIPP job, clear the Print Range parameter. If you don’t clear 
this parameter, the job might fail in the In Print queue and then the following message would 
appear:  

Job Failed in Print. Please try to resubmit the job.  

After the job is RIPed, you can select the Print Range option again. 

VI Job Thumbnails 

• If you use the Job Preview & Editor tool to view thumbnails of VI jobs that include 
multiple records, the generation of all the thumbnails on the pages of the selected VI job can 
take some time. While the thumbnails are being generated, no other job can be selected. 

• Open the thumbnails of VIPP and/or Variable Print Specification jobs that have already been 
RIPed and are in the Storage Folder only if you want to view thumbnails of the entire VI job. 

File-Naming Convention 
Make sure that you follow the naming conventions specified in the CXP5000 Printing Guide. 
Improper characters and file names with spaces can cause problems. 

• Avoid using the following characters in image and job file names : ! @ # $ % ^ & * ( ) - / ? > 
< ' " ; : ] [ { } \ |. In some cases, the Spire CXP5000 color server substitutes an underscore ( _ 
) in file names that contain these characters. As a result, the high-resolution images cannot be 
used when Creo APR is in use.   

• Do not enter a space at the beginning or end of a file name. 

• Before you create any Darwin Variable Print Specification file, it is recommended that you 
check the database file and all image files for invalid characters and then edit the files. 

Variable Print Specification Image Files 
The Spire application supports file types that use the Creo APR (Automatic Picture 
Replacement) feature and the Synapse PrintXT extension. The supported file types are EPS, 
TIFF, and CT. 

Note:  General PostScript errors may result when Synapse PrintXT is set to perform image 
swapping on unsupported file types (PDF, LZW compressed TIFF, and grayscale bitmaps).  
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Print Shop Mail Jobs 

• Print Shop Mail jobs that contain VI elements in landscape orientation are processed and 
printed in portrait orientation. 

• Print Shop Mail supports EPS images only. 

• Variable Print Specification files that are generated from Print Shop Mail version 4.36 for 
Macintosh and version 4.1 ~build 72 for Windows are not imposed correctly in the Spire 
CXP5000 color server. 

Application Notes 

Microsoft Office Programs 
In Microsoft Windows NT and Windows 2000, you cannot define custom page sizes in 
Microsoft Word. The setting reverts back to A3.  

QuarkXPress 

Printing Transparencies 
To print transparencies from QuarkXPress®: 

In the Page Setup dialog box under PPD options, select a page size (A4 or Letter), and then 
select the media type (Transparency). 

In imposition, when you use QuarkXPress files with a custom paper size and landscape 
orientation, define the width and height of the paper as follows: 

• Document setup: Set the width to a long edge measurement, for example, width =11 inches. 
Set the height to a short edge measurement, for example, height = 8.5 inches. 

• Print window: Set the width to a short edge measurement, for example, width = 8.5 inches. 
Set the height to a long edge measurement, for example, height = 11 inches. 

• PPD, Custom: Set the width to a long edge measurement, for example, width =11 inches. 
Set the height to a short edge measurement, for example, height = 8.5 inches. 

In the Printer Driver dialog box, on the Output tab, the only available resolution is 300dpi, 
although the DocuColor 2045 and 5252 printer prints files in 600dpi. Disregard the resolution 
setting. 
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PageMaker 

• All operating systems enable you to select transparencies with a custom paper size, but the 
printer can print transparencies only in A4 and letter size. 

• All operating systems enable you to select a custom paper size and tray 1 or 2, but the printer 
can print custom paper sizes only from trays 3 and 4. 

PageMaker in Windows 

• In PageMaker®, there are no error messages from the PPD when you select the HCSS and 
Printer Default (Face Up). Face down must be selected. 

• For PageMaker files for which you have selected Landscape orientation and Duplex mode 
properties, Head to Head prints as Head to Toe, and Head to Toe prints as Head to Head. 

• In PageMaker 6.5, there is no PPD constraint when you select the Staple option and then 
choose Face Down and Collate. 

PageMaker in Mac OS 

• You cannot define a custom page size in PageMaker for Macintosh. The page size reverts to 
letter. An image that is larger than letter size, is cropped. 

• On a Macintosh, if you use PageMaker and select the Staple option, the Admin Page prints 
incorrectly. The first sheet of the job is duplicated and is printed instead of the Admin Page. 

Adobe Acrobat 

• For Adobe Acrobat® (Windows version) PostScript files that are set to Duplex mode, Head 
to Head prints as Head to Toe. 

• For Acrobat files that are set to Landscape orientation and Duplex mode, Head to Head 
prints as Head to Toe. 

FreeHand 

In FreeHand, if you select the Staple option, the Admin Page does not print. 

Known Limitations of Adobe PostScript Features 

The following applications do not support all PostScript features. Usually the application simply 
ignores the feature, but in rare cases, a printing error occurs. 
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Application Unsupported Driver Options 

Acrobat 5.05 Rotated Landscape, Mirror Image, Negative Image 

CorelDRAW® 10.0 Scaling, Mirror Image, Negative Image 

FrameMaker® 5.5 Rotated Landscape 

FreeHand 9.0, 10.0 N-up, Scaling, Landscape, Rotated Landscape, Mirror Image, 
Negative Image, Watermark, OpenType 

Illustrator 10.0 Watermark, Euro 

InDesign® 2.0 Scaling  

PageMaker 7.0 N-up, Scaling, Rotated Landscape, Mirror Image, Negative Image, 
Watermark, Euro 

Photoshop 6.01 Watermark, Euro 

QuarkXPress 4.11 N-Up, Rotated Landscape, Mirror Image, Watermark, Euro,  

Note:  Some applications support Rotated Landscape only when it is set as the default from the 
Printers folder. 

Workaround: Do not use these PostScript features when you print from the applications listed. 
Newer versions of these applications may resolve these incompatibilities. 

Supported Microsoft Hot Fixes  

Hot Fix No. Date File Name 

MS03-026 July 16, 2003 823980 

MS03-032 August 20, 2003 822925 

MS03-039 September 10, 2003 824146 

MS03-040 October 3, 2003 828750 

MS03-041 October 15, 2003 823182 

MS03-042 October 15, 2003 826232 

MS03-043 October 15, 2003 828035 

MS03-048 November 12, 2003 824145 
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